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Getting Started with Light-O-Rama

Welcome to Light-O-Rama

Light-O-Rama is a computerized lighting system designed to control elaborate or simple lighting
displays. The Light-O-Rama system can be applied to almost any lighting situation, from stand-alone
controllers to synchronizing hundreds of controllers.

This page gives a high-level oveniew of how to start controlling your lights using Light-O-Rama:

e Getting Help about Light-O-Rama

e Important Terms and Information

e Connecting the Lights Using Light-O-Rama Controllers
o Creating a Show

For more detailed information, please see Light-O-Rama Concepts and the Light-O-Rama Software
Package.

Experienced users may wish to see what's new in the latest version of Light-O-Rama.

Getting Help about Light-O-Rama
Other than this help file, there are several ways to get help about Light-O-Rama:
Frequently Asked Questions, quick start guides, training presentations, tutorials, demos, and user
guides can be found on the Support page of the Light-O-Rama website, along with phone, mail, and
email contact information.
Light-O-Rama users' forums can be found at the LOR Users Support Center.
The LOR Wiki is a user-created and edited repository of Light-O-Rama information. Please note

that the information contained in the LOR Wiki is not published by Light-O-Rama, and cannot
be considered official.

Important Terms and Information

Companion Unit

A companion unit is a Light-O-Rama controller that receives lighting commands from another
source - either a PC running Light-O-Rama software, or from another controller known as a director
unit.

Control Panel

The Light-O-Rama Control Panel is a program that can be used to manage the Light-O-Rama
system on your PC. The Control Panel runs in the system tray (where the PC's clock is displayed).
Light-O-Rama is made up of a number of different programs, and the Control Panel is a convenient
way of accessing them. The Control Panel must be running in order to control shows from your PC.

Daisy Chain

© 2009 Light-O-Rama, Inc.
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This is the term generally used to describe the manner in which Light-O-Rama light controllers are
connected. A wire goes from the source (a PC running Light-O-Rama software or a director unit) to
a companion unit. Another wire goes from that companion unit to another companion unit, and so
on, until all companion units are "chained" together.

Do not put "Y"s or forks in the data cable. Only connect the units in this daisy chain configuration.

Data Cable

Light-O-Rama controllers can be connected using both data cables and phone cables, but you must
know which type of cable it is (for the purposes of Light-O-Rama, a cable is considered a data
cable if its wires are connected straight through).

How do you know if it is a data cable? Well, most likely the only cable that you will see that is not a
data cable is a wire that is intended specifically for phones. If you go to your local hardware store
and purchase a phone extension cable, then that wire is not a data cable. The distinction between
data cables and phone cables is important, because the wires are swapped around. There are
selectors or jumpers on most Light-O-Rama controllers that allow you to specify which wire type you
are using.

Only the wire coming into a controller (from the previous controller or from a PC running Light-O-
Rama software) should be used to determine which selector setting to use. The wire leaving a
controller (if there is one) can be of any type, and has no bearing on which selector setting should
be used. For example, if a controller has a phone cable coming in from the previous controller, and
a data cable leaving to the next controller, the selector should be set for "phone cable"”.

Director Unit

A director unit is a Light-O-Rama controller that sends lighting commands to other controllers
(known as companion units). Controllers can run individually in standalone mode, but to
synchronize multiple controllers together, they must be directed either by a PC running Light-O-
Rama software, or by a director unit.

Standalone sequences may contain lighting commands for a number of different units. A director
unit is a unit that is running standalone - i.e. not connected to a PC - that contains lighting
commands for other units cabled to it (the companion units). The director unit can also control its
own lights, simultaneously.

There is no difference in the hardware of a director unit and a companion unit - the only difference is
the mode that they are in.

A PC running Light-O-Rama software can also be thought of as a director unit, in that it can send
lighting commands to Light-O-Rama controllers. There must be one and only one director unit (or
PC running Light-O-Rama software) on a daisy chained group of controllers.

Hardware Utility

The Light-O-Rama Hardware Utility is a program that can be used to set up and test the hardware
used to control lights, as well as download sequences to standalone controllers or director units.

Phone Cable
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Light-O-Rama controllers can be connected using either data cables or phone cables, but you
must know which type of cable you are using. See data cables for details.

Schedule

A schedule is a list of shows and the times at which those shows are to be played.

If the Light-O-Rama Control Panel is running on a PC, and its "Enable Shows" option is turned on,
then the schedule will be monitored, and its shows will be started and stopped at the appropriate
times.

The Schedule Editor program is used to create and modify schedules.

Sequence
A sequence is a file that contains a set of lighting commands to be sent to Light-O-Rama
controllers. There are two types of sequences: musical sequences, which have an associated

music or video file that is to be played at the same time, and animation sequences, which do not.

Sequences can be grouped together into shows.

The Sequence Editor program is used to create and modify sequences.

Show
A show is a file that contains a number of sequences, and the order in which they should be played.
A schedule can be created to specify the times at which various shows should be played.
The Show Editor program is used to create and modify shows.

Standalone
A Light-O-Rama controller can be controlled by another controller (or a PC running Light-O-Rama
software), or it can control itself and/or other controllers, in standalone mode. A sequence,
created using the Sequence Editor, can be downloaded to a standalone controller using the
Hardware Utility. The controller can then be set up to run this sequence whenever it has power, or, if
the unit is a model with an internal clock, it can be instructed to run the sequence during a particular
time.
A standalone controller whose sequence contains lighting commands for other controllers will

transmit those commands to the other controllers. In this case, the controller is known as a director
unit.

Unit

A unit is another term for a Light-O-Rama controller. Each unit has a number of circuits, each of
which can be used to control lights independently of each other. Each unit is identified by a unit ID.

Unit ID

© 2009 Light-O-Rama, Inc.
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Each unit has an identifier assigned to it, known as a unit ID. When a lighting command is sent to
a unit, all of the units that are daisy chained together can see that command. Howeer, the
command contains a unit ID; only the units having that unit ID will act upon that command.

For Light-O-Rama controllers, the unit ID is a two characters, each of which can have any of the
values 0,1, 2, 3,4,5,6,7,8,9, A,B,C, D, E, and F. For example, "01", "25", "37", "5C", "BD", or
"E2". However, not all possible combinations are allowed: "00" and "F1" through "FF" are
disallowed.

Controllers other than Light-O-Rama controllers use different formats for their unit IDs.

Connecting the Lights Using Light-O-Rama Controllers

To connect lights using Light-O-Rama controllers, take the following three steps:

1. Determine the serial port and hook up a controller.
2. Select a unit ID.

3. Test the lights.
Step 1. Determine the Serial Port and Hook Up a Controller

Insert an SC485 converter into your PC's DB9 serial connector which you plan on using for the Light-
O-Rama network. If you are using a USB/RS-232 conwerter, then make sure that it is properly
installed, and that the SC485 conwerter is connected. If you're not sure what all this is about, simply
try to find a connector on the back of your PC that has nine pins and which will accept the SC485
adaptor.

Using a cable, connect a Light-O-Rama controller to the SC485 adaptor. Make sure that the LOR
controller is powered on. The LED in the controller should be blinking.

Using the Light-O-Rama Control Panel, start the Hardware Utility program. In the Hardware Utility's
Setup Comm Port section, use the Auto Configure button. This will cause the Hardware Utility to
look for the attached controller and determine which comm port is being used.

Step 2. Select a Unit ID

If your controller has unit ID selection switches, you can select its ID by adjusting the selectors to
the desired ID. If your controller does not have these unit ID selection switches, then you will need
to set its unit ID by using the Hardware Utility:

To set the unit ID using the Hardware Utility, connect one and only one unit to the PC using the
SC485 adaptor and a cable. In the Set Unit IDs section, go to Set New Unit ID, select the ID that
you wish to use for the controller, and click the Set Unit ID button. This button will only work on
new units that have never been assigned a unit ID (to change the unit ID of a unit that already has
one assigned, use the Change Existing ID section instead).

TIP: Assign unit IDs sequentially, starting at 01. This will make maintenance of the units faster.

Step 3. Test the Lights

With the unit connected to the PC, attach lights and power the unit on. In the Hardware Utility, click
the Refresh button in the top center of the screen. After a short time, your unit should appear in the
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dropdown list to the right of the Refresh button. Select the unit, and you can then test the lights
using the various controls in the Test Unit's Operation section of the Hardware Utility.

TIP: Before clicking Refresh, set the Hardware Utility's Max Units to as low a value as possible.
This number is the maximum number of controllers that you plan on using (you can always change
it to a higher number if you add more controllers later). Setting the number to a low value makes the
Hardware Utility run faster.

Creating a Scheduled Lights Display

To create a lights display and hawe it run at certain times, take the following steps:

1. Make your sequences.
2. Make a show.

3. Make a schedule.
4. Turn on the Control Panel's "Enable Shows".

Step 1. Make Your Sequences

Using the Sequence Editor, create the sequences that will be used in your show.

You can test how the lights will look for a sequence while in the Sequence Editor: Make sure
Control Lights is turned on in the Play Menu, and that you have assigned the channels in the
sequence to a controller that is hooked up to your PC. Then, click the play button (which is the
green arrow in the toolbar).

Step 2. Make a Show

A show is a collection of sequences. A show can be created using the Show Editor program.
Shows hawe seweral sections, each of which can have sequences:

e Background: Sequences listed in the "background" section will be played for the entire
duration of the show.

e Startup: Sequences listed in the "startup” section will be played when the show first begins.

e Animation and Musical: After the "startup” sequences have completed, sequences in both of
these sections will run, until it is time for the show to stop.

e Shutdown: When it is time for the show to stop, the "animation" and "musical" sequences
will stop running, and the sequences in the "shutdown" section will start. Only after the
"shutdown" sequences are finished will the show truly end.

In the Show Editor, you can add sequences to any of these sections by selecting the appropriate
section's tab, and hitting the big PLUS button.

After you have created your show, you should sawe it using the "Sawe" or "Sawve As" button. Assign
the show a meaningful name - this is the file name that you will be using in the next step.

Step 3. Make a Schedule

Unlike sequences, you cannot run a show interactively. Instead, to test a show, put that show into
a schedule, using the Schedule Editor program:
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In the Schedule Editor, click the Add button, and select the show file with the name that you
created in the previous step. Select a start and end time that will allow the show to start at a
conwvenient time for you to view it. Then click Save to save your schedule.

Step 4. Turn On the Control Panel's "Enable Shows"

To view the scheduled show, turn on the "Enable Shows" option in the Light-O-Rama Control Panel.
Doing this will cause the Control Panel to monitor your schedule, and start and stop your show at
the appropriate times.

2 What's New?

What's New in Light-O-Rama

What's New in Version 2.4.10
What's New in Version 2.4.8
What's New in Version 2.3.8
What's New in Version 2.3.6
What's New in Version 2.3.4
What's New in Version 2.1.6
What's New in Version 2.1.4
What's New in Version 2.1.2
What's New in Version 2.0.16
What's New in Version 2.0.14
What's New in Version 2.0.12
What's New in Version 2.0.8
What's New in Version 2.0.4
What's New in Version 2.0.0
What's New in Version 1.5.0
What's New in Version 1.4.0

What's New in Version 2.4.10

The following changes were made in this version:

Exporting/importing channel configuration with tracks improved
Commands sent to Holiday Lights Designer regardless of licensing level
Hardware Utility supports DIO32 servo configuration

Refresh command made quicker

Bug fixes

Exporting/Importing Channel Configuration with Tracks Improved

In previous \ersions of Light-O-Rama, exporting and importing channel configuration from and to
sequences that have more than one track could lead to strange, and probably undesired, results.
This was due to the interaction between channels that were in more than one track of the sequence
and channels that were in more than one track of the configuration file. If the positions of such
channels did not match up between the sequence and the configuration file, then the resulting
settings of those channels would be changed in a predictable, but probably undesired, way.
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In this version, the method of importing has been altered, so as to give (hopefully) better results:

Unlike in previous versions, the first step to importing channel configuration, before any channels are
actually imported from the configuration file, is now to check the sequence for channels that are in
more than one track. If any such channels are found, then all copies of each channel, except for the
first of each channel, are removed from the sequence.

Next, channels are imported from the configuration file. But unlike in previous versions, if a channel
is in more than one track of the configuration file, instead of overwriting the settings of an existing
channel in the sequence every time the channel is encountered in the configuration file, that is only
done on the first encounter of the channel. Instead, on subsequent encounters of the same channel,
a copy of the appropriate channel from the sequence is inserted into the track at the appropriate
position.

This has two potential side effects to watch out for (although both of these seem minor compared to
the side effects caused in previous versions):

First, if a track in the sequence is composed entirely of channels from previous tracks, and the
channel configuration file has no track in the same position, then all channels will be removed from
that track. Since the track has no channels, it will then be removed from the sequence. Howewer,
note that these channels have not been removed from the sequence - they have only been removed
from the track. They are still in the earlier tracks.

Second, a channel from the sequence with no corresponding channel in the configuration file could

get "pushed down" towards the bottom of the sequence's track, if the channel configuration file
contains channels in that track which are copies of channels from earlier tracks.

Commands Sent to Holiday Lights Designer Regardless of Licensing Level
Different licensing lewvels can control different numbers of controllers; for example, the Basic level can
control two controllers, while the Advanced level can control an unlimited number of controllers. If a
sequence contains a lighting effect for a controller that the license level cannot control, the effect is
simply not sent to the controller.

In previous versions, this also applied to sending commands to Holiday Lights Designer: lighting
effects could be sent to Holiday Lights Designer only if they could be sent to an actual controller,

based on the license level. Now, lighting effects can always be sent to Holiday Lights Designer,
regardless of the licensing level.

Hardware Utility Supports DIO32 Servo Configuration
The Hardware Utility can now be used to configure the DIO32 for servos.
Refresh Command Made Quicker

The Hardware Utility's Refresh command, used to scan a Light-O-Rama network for controllers, now
works more quickly than it did before.

Bug Fixes

¢ If a show contains some sequences in a "Magic Toy" interactive group, and a trigger in that group
is triggered, any playing sequences that happen to be from that same interactive group should be,
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but were not, stopped, before the newly triggered sequences start.

e The Channel Property Grid would allow you to remowe the last channel from a track, which would
lead to undesired behavior. It now no longer allows the last channel to be removed from a track.

e There must be a channel in every track; Light-O-Rama should prevent you from removing the last
channel from a track. Due to bugs, though, it's possible that the last channel could be removed
from a track; in such a case, if the sequence were saved, it could not thereafter be reloaded. In
this version, the sequence can now be loaded, but any tracks without channels will automatically
be remowved from the sequence during the load.

¢ Input triggers would work correctly only for the first eight circuits of a controller. They now work on
the full sixteen.

What's New in Version 2.4.8

The following changes were made in this version:

e Tapper Wizard improvements

e Animator's twinkle effect made more realistic

 Fade Tool Settings and Intensity Tool Settings can be toggled on and off
e New keyboard shortcuts for selecting the current tool

e Keyboard editing while using the Animator made easier

¢ File saving made safer

e Track bar of active track highlighted

e Bug fixes

Tapper Wizard Improvements
The Tapper Wizard was improved in several ways:

¢ It now knows about timing grids. You can select an existing grid to use, or create new grids to
use, from within the Tapper Wizard itself.

¢ Inserting timings and inserting lighting effects can now be done independently of each other - you
can do either or both.

e You can play a particular part of a song, rather than the whole song. When the Tapper Wizard is
first opened, its play range will automatically be set to the active track's freeform play range, if
there is one, or to its normal play range (such as play full sequence or play \isible screen) if not.

e You can set the play speed, either to normal speed, half speed, or double speed.

¢ It can be used repeatedly without closing, with or without tapping again. For example, after
applying your taps to the sequence, you could collect a whole new set of taps, or you could apply
your existing taps to the sequence again, in a new way (such as applying them to a different
channel, or with different flash and fade times), all without ever closing the Tapper Wizard.

e It supports undo and redo within itself, you do not hawve to close the Tapper Wizard to undo or redo
its changes.

¢ It no longer relies on helper forms to collect information (such as the length of time that a flash
should take); this information is now set via fields on the Tapper Wizard itself.

e The settings that you choose, such as whether to use a countdown, how long that countdown
should be, whether to use the mouse, the keyboard, or both, what kind of effects or timings
should be inserted, and so forth, are remembered, so that you do not have to change them every
time that you enter the Tapper Wizard.

Animator's Twinkle Effect Made More Realistic

Recent efficiency improvements to the Animator increased the speed it could redraw at. This had
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the side effect of making its twinkle effects twinkle too quickly, almost looking like shimmers. The
Animator's twinkle effect has now been slowed back down, to more closely resemble the twinkle

effect on actual lights.

Please note that this change does not affect the way that twinkle behaves on your lights at all; they
will behave exactly as they always have. It only affects how twinkle is represented in the Animator
(which is an approximation, not an exact representation, of how it looks on actual lights).

Fade Tool Settings and Intensity Tool Settings Can Be Toggled On and Off

In previous versions, clicking of the Fade Tool Settings toolbar button would open the Fade Tool
Settings dialog, as would clicking on the Tools menu's Fade Tool Settings item. The only way to
close the dialog was to click on its Windows close button, or to use the escape key. Now, the
toolbar button (or the menu item) can be used as a toggle - clicking it once shows the dialog;
clicking it again hides it.

A similar change was made for the Intensity Tool Settings dialog.

New Keyboard Shortcuts for Selecting the Current Tool

When editing sequences \ia the keyboard, previous versions would allow you to hit the Enter key to
apply the current tool to the selected area of the sequence. Alternatively, to apply a different tool,
you could hit some other key, specific to that tool; this would leave the current tool the same as it
was. For example, if the current tool was the shimmer tool, you could hit Enter to apply a shimmer,
or "T" to apply a twinkle.

Howevwer, the current tool itself could not be selected except via the toolbar, or menu items on the
Tools menu. It can now be selected via the keyboard as well, by using Shift in addition to the
desired effect's normal key. For example, Shift-T will change the current tool to change the current
tool to be the twinkle tool. Note that this leaves the sequence itself untouched (but you can still hit
Enter to apply the current tool to the sequence, or one of the specific keys to apply some other
tool).

Due to this change, certain existing keyboard shortcuts had to be remapped. Specifically, Shift-S,
Shift-T, Shift-l, Shift-U and Shift-D used to change the current custom tool to be a custom shimmer,
twinkle, intensity, fade up, or fade down, respectively. These have been replaced with Ctrl-Shift-S,
Ctrl-Shift-T, Ctrl-Shift-I, Ctrl-Shift-U, and Ctrl-Shift-D, respectively.

Keyboard Editing while Using the Animator Made Easier
When you click on a control in the Animator, after that control's operation has completed, the focus
is now immediately given back to the sequence grid. The effect of this is that you can continue
using the keyboard to edit the sequence without needing to mouse-click on it every time you change

something in the Animator.

File Saving Made Safer

Previously, when the Sequence Editor saved a sequence, it would delete the backup file of that
sequence, then rename the existing sawe file to the backup, then write a new version of the sawe file,
then verify that it could load the new version of the sawve file. If it could not load the new version, it
would give a warning message saying so, and giving the name of the backup file.
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Instead, it now writes the sequence to a temporary file, then verifies that it can load that temporary
file. Only ifit can load the temporary file does it then proceed to delete the backup file, rename the
existing sawe file to the backup, and finally rename the temporary file to the real sawe file name.

Track Bar of Active Track Highlighted

In the Sequence Editor, the track bar of the currently active track in a sequence is now colored
green, so as to make it easily distinguishable from the other tracks.

Bug Fixes

¢ In the Sequence Editor, if the total time of a track was increased, and that track was currently

using a fixed timing grid, an error message would pop up saying that timings cannot be added to
fixed grids.

¢ If the Windows option "Hide extensions for known file types" was turned on, the New and Open
dialog's "Existing Sequence” tab would not properly display the type of each file.

What's New in Version 2.3.8

This version fixes the following bugs:

¢ In the Sequence Editor, when the mouse was mowved to the left of the channel bar, an error
message would sometimes pop up, saying "Invalid centisecond for finding timing", followed by a
negative number. This would always happen when the mouse was dragging, and sometimes
happen otherwise.

¢ On some computers running Windows Vista, installation would fail, giving an error about
Microsoft's MDAC component.

What's New in Version 2.3.6

This version fixes the following bug: Upon upgrade from a previous version of Light-O-Rama, if the
user chose a different directory to store sequence and audio files than was chosen for the previous
version, the post-install process would neglect to copy the files from the old directory to the new
one.

What's New in Version 2.3.4

The following changes were made for Light-O-Rama version 2.3.4:

e Timing grids

e The Light-O-Rama Verifier

e Beat Wizard and VU Wizard improvements

e Initial play of sequences sped up

o Events straddling the start of a play range are played

¢ New and Open dialog improvements

¢ New musical sequence's initial channels can be based on a channel configuration file
¢ New musical sequence's artist, album, and song names pulled from MP3
e Support for normally closed input triggers

¢ Interactive triggers can be tested in the Hardware Utility

e Maximum and minimum intensities read from controller

o Extra Information in sequence grid tooltips
e Control Panel's status window can be minimized
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Fades are smoother in the Animator

Animator CPU utilization improved
Animator redraw throttling configurable
Zooming with the Animator's autosize mode
Bug fixes

Timing Grids

A timing grid is a collection of timings. A seguence can have more than one timing grid, but only
one (per track) is displayed at any given time. You can quickly change which timing grid is

displayed at any time by selecting from the Tracks and Timings toolbar's timings dropdown list.

There are two types of timing grids: fixed timing grids, which have timings at equal distances from
each other, and which cannot have timings added, removed, or moved, and freeform timing grids,
which can have timings anywhere, and which can have timings added, remowved, or mowved.

Timing grids are intended to better fulfill a role that was fulfilled in previous versions of Light-O-Rama
by tracks: Allowing different sets of timings to be used on the exact same channels.

For example, perhaps you have a song for which you would like some lighting effects sequenced to
the sound of the bass drum, and other lighting effects sequenced to the sound of the lead guitar.
You could simply add timings for both, but this could make it easy to forget which timing is for which
instrument; it could also make the display seem too cluttered with timings.

To solwve this problem in previous versions of Light-O-Rama, you could duplicate the track to a new
track, so that you had two different tracks in the sequence, both with the same channels as each
other. The two tracks could use different timings, one track representing the bass drum and the
other representing the lead guitar.

You can still do that in this new version of Light-O-Rama, but you can now instead solve the problem
by using timing grids. Instead of adding a second track, you could add a second timing grid. One
timing grid would represent the bass drum, and the other would represent the lead guitar. You could
quickly switch which timing grid is displayed using the Tracks and Timings toolbar's timings
dropdown list, changing back and forth between drum and guitar as appropriate, all with only a single
track.

The Tracks and Timings toolbar also has a timings button; clicking on it will open a popup menu with
various timings grid-related options, such as adding a new timing grid or deleting an existing one.

When this new version of Light-O-Rama opens a sequence created with a previous version (in which
there was no such thing as a timing grid), it will automatically create one freeform timing grid per
track in the sequence.

The Light-O-Rama Verifier

The new Light-O-Rama Verifier program can be used to check for certain types of problems with
your Light-O-Rama configuration, schedule, shows, and sequences. By using the Verifier, you may
be able to fix these problems before they cause any issues when your show is played.

Beat Wizard and VU Wizard Improvements

In previous \ersions, the Beat Wizard and the VU Wizard would always add timings, regardless of
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whether they were also adding effects or not. They can now add timings and effects independently
of each other.

Also, when inserting effects, they can now optionally snap them to the timings being used.

Initial Play of Sequences Sped Up

The amount of time that it takes for a sequence to start playing the first time after it is loaded (or
after it is changed or the play range is changed) has been decreased.

Events Straddling the Start of a Play Range Are Played

In the Sequence Editor, if the play range is set to anything other than the full sequence, and an
effect event starts before the play range starts but ends during (or after) the play range, previous
versions of Light-O-Rama would not control the lights based upon that event. Instead, now, the
portion of the event within the play range is sent to the lights (for example, if the event is a fade up
from 0% to 100% from 36 seconds to 38 seconds, and the play range starts at 37 seconds, the
lights will be sent a command to fade up from 50% to 100%).

New and Open Dialog Improvements
Several improvements were made to the Sequence Editor's New and Open dialog:

In previous ersions, the dialog was a fixed size, which could not be changed. It can now be resized
or maximized, and will remember its sizing and positioning even after the Sequence Editor is closed
and restarted.

The dialog's Existing Sequence tab used to always show a list of folders and sequences in a single
way. It now has an option to change the view, similarly to Windows Explorer. For example, if the
"Details" view is selected, then in addition to file names, details such as file sizes and modification
dates will be displayed. Clicking on a column header in the "Details" view will sort the files by that
column; clicking on it again will sort in reverse order. The dialog will remember the selected view
and sorting behavior even after the Sequence Editor is closed and restarted.

The Existing Sequence tab now also has a "Search" box. If you type something into this box, only
files with that somewhere in their name will be listed. Wildcard characters (*, ? and #) are supported
in the search box.

The Standard Toolbar's "Open" button would previously always open the dialog to the "Existing

Sequence" tab. It now instead opens it to whichever of "Existing Sequence" or "Recent Sequence"
was most recently used.

New Musical Sequence's Initial Channels Can Be Based on a Channel
Configuration File

When you create a new musical sequence, the New Musical Sequence dialog now lets you base
the initial channels for the sequence off of the contents of a channel configuration file, rather than

simply specifying a number of channels.
New Musical Sequence's Artist, Album, and Song Names Pulled from MP3

If you create a musical sequence based on an MP3 file, the New Musical Sequence dialog
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automatically uses the artist, album and song names from the MP3 itself (if the MP3 is tagged with
this information). You can still change these in the dialog if you wish.

Support for Normally Closed Input Triggers

Previous versions of Light-O-Rama only supported normally open circuits for use as input triggers.
Normally closed circuits are now supported as well, via the Hardware Utility's LOR controller

configuration screen.

You may need to update the firmware of your controller in order to take advantage of this new
feature.

Interactive Triggers Can Be Tested in the Hardware Utility

The Hardware Utility's LOR controller testing screen can now be used to test input triggers from LOR
controllers.

Maximum and Minimum Intensities Read from Controller

The Hardware Utility's LOR controller configuration screen can now read the maximum and minimum
intensity settings of a Light-O-Rama controller from the controller itself.

You may need to update the firmware of your controller in order to take advantage of this new
feature.

Extra Information in Sequence Grid Tooltips

The tooltip displayed in the Sequence Editor when the mouse howers ower a cell in a sequence now
includes more information than before, including details on the effect event being hovered ower.

You can configure various settings about the tooltips, such as how long they take to open and how
they close, via the Display Preferences dialog.

Control Panel's Status Window Can Be Minimized

The status window of the Light-O-Rama Control Panel can now be minimized to the Windows task
bar.

Fades Are Smootherin the Animator

The Animator used to display fades in a somewhat jerky manner, only updating the display after the
color of a cell has changed by a fairly significant amount. Depending upon the speed of the fade,
this would lead to fades more as steps through several intensities rather than as actual fades (note
that this only affected the appearance of the Animator, not the appearance of any real lights that you
had hooked up \via controllers). Fades should now appear more smoothly in the Animator.

Animator CPU Utilization Improved

Various changes were made to the Animator to decrease the amount of CPU time that it takes to
display the animation.

Animator Redraw Throttling Configurable
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During play, the Animator only redraws the animation every so often, rather than every time that
something changes. This is to try to ensure that it does not use too much CPU time. In the past,
the amount of time between redraws was a certain constant value; now, you can modify it in the
Display Preferences dialog, to try to strike an appropriate balance between CPU usage and
smoothness of display for your individual computer.

Zooming with the Animator's Autosize Mode

When the Animator's controls are hidden, expanding and contracting the Animator's window is
supposed to also automatically resize the drawing area within the window. Howewer, due to certain
sizing requirements, the drawing area can only be certain possible sizes for any given animation.
So, when the window was manually resized by clicking and dragging a side or a corner, the drawing
area would remain the same size, until the window got large enough to hold the next possible size,
at which time the drawing area would "jump" to the new size.

To make this autosizing quicker and easier, the ability to manually resize by dragging a side or a
corner of the window has been replaced by "zoom" buttons on the toolbar, which will immediately
resize the window (and the drawing area) to the next possible size.

Bug Fixes
This release fixes the following issues:

¢ If the same show had been scheduled twice back-to-back, it would have simply continued playing
rather than stopping and restarting.

¢ If a channel was set up to represent a subsequence, changing the subsequence file associated
with the channel would not cause the channel's main sequence to be marked as having unsaved
changes.

¢ If a musical sequence based on a MIDI file was playing in the Sequence Editor, and was paused
or stopped before its natural end, and the sequence had used the MIDI Wizard, then the
Sequence Editor would not send out MIDI commands saying to stop sounds. This caused
whatever notes happened to be playing when the sequence was paused or stopped to continue
playing indefinitely.

¢ If the VU Wizard were used to toggle cells on and off during part of a song, as opposed to the
entire song, it would sometimes get the toggling backwards, turning on cells that should have
been turned off, and vice versa.

¢ If the VU Wizard were used to toggle cells on and off during part of a song, as opposed to the
entire song, it would not necessarily get the state of the first or the last cell in the range correct.

¢ If the VU Wizard were set up such that the entire selected area of the song was below the
specified peak threshold, an error box would appear, saying "Subscript out of range”.

¢ If an animation had a background image, and the Animator's controls were hidden, resizing the
window would not necessarily keep the image's proportions as they were.

¢ If the Animator's controls were hidden, resizing the window would only automatically resize the
animation if it had a background image.

e The menu items on the Wave Form submenu of the Sequence Editor's View menu would not
become checked until one of them (or the View Waveform button on the Standard Toolbar) was
clicked.

e When the Sequence Editor's New and Open dialog is first opened, its dropdown list of folders did
not include all of the immediate child folders of "My Computer".

¢ In the Hardware Utility's Test Consale, clicking the "All Off* or "All On" buttons would mowe the
intensity sliders appropriately, but would not update the text boxes beneath them to say the new
intensities.

© 2009 Light-O-Rama, Inc.



20

Light-O-Rama v2.4.10

If Windows suspended while the Sequence Editor was open, and a USB adapter was in use for

an LOR comm port, then when Windows resumed, the Sequence Editor would be locked up.

The Hardware Utility would shut down without warning if "Lights Off* or "All Off* were pressed while
the LOR comm port was set to a port number that could not be initialized.

The Hardware Utility would shut down without warning upon trying to initialize an X10 CM-11A
device on a port that had (till that point) been assigned to LOR devices.

What's New in Version 2.1.6

This version fixes the following bugs:

If the waveform display were used with a completely silent audio file, the Sequence Editor would
crash.

If a sequence had a Windows shell command, and it were saved to a different filename than it had
been loaded with, future changes to the Windows shell command in one of the two sequences
would affect the Windows shell command in the other sequence as well.

Shows scheduled by the Simple Show Builder, and run via the PC, would not necessarily end at
their appropriate time.

What's New in Version 2.1.4

This version fixes the following bugs:

In certain situations, adding a sequence to an MP3 Player Showlist would fail, with an error
message saying "Path/File Access error".

Sequences downloaded to an MP3 director would have their final lighting effect cut off prematurely.
The Sequence Editor's New Musical Sequence Preferences dialog would not allow you to change
the default timings to certain values ("MIDI Wizard", "Beat Wizard", and "VU Wizard") if you
opened the dialog via the "New Musical Sequence Preferences” menu item on the Preferences
submenu of the Edit menu.

What's New in Version 2.1.2

The following changes were made for Light-O-Rama version 2.1.2:

Licensing

Custom fade/intensity twinkles and shimmers

Triggered interactive sequences

Show startup options

Windows shell commands

DMX intensity

The New and Open dialog

Keep lights on at end of play

Automatic channel settings for newly created sequences
Events can be dragged with timings

Change in behavior for mouse switching tracks
Animation sequences in the musical section cut off at end of show
"Max Units" in Hardware Utility changed to "Max Unit ID"
Bug fixes

Licensing
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The Light-O-Rama Software Package must now be registered with a valid license in order to unlock
its full potential. There are several different license lewels, each with different features available.
Additionally, Light-O-Rama can be run without a license, as a Demo version; the Demo version
cannot be used to actually control lights, though.

Existing customers who have purchased earlier versions of the Light-O-Rama software package are
entitled to a free license of the highest level ("Advanced").

For details about registering and about the features available with the different licenses, please see
Registering Light-O-Rama and Feature Comparison.

Custom Fade/Intensity Twinkles and Shimmers

In previous versions of Light-O-Rama, twinkling or shimmering the lights could only be done at full
intensity. You can now use new custom tools to twinkle or shimmer the lights while fading them up
or down, or at some intensity other than full intensity.

Existing Light-O-Rama controllers may need firmware upgrades to take advantage of this new
feature; if a custom twinkle or shimmer is sent to a controller without the upgrade, it will react as if it
were a "regular” twinkle or shimmer - i.e. it will twinkle or shimmer at full intensity.

Triggered Interactive Sequences

In addition to being able to control lights, some Light-O-Rama controllers can now act as input
triggers. This allows sequences to be played on demand during a show - for example, your display
may have a group of buttons that people can press, each of which will cause a different song to be
played.

For details, please see the help file page "Interactive Groups".

Show Startup Options
In previous ersions of Light-O-Rama, the sequences in a show would start playing immediately at
the show's scheduled start time. There is now more flexibility with regards to this; for example, you

could hook a big red button labeled "Start the Show" up to one of your Light-O-Rama controllers,
and the show will not be started until that button is pushed.

For details, please see "Show Startup Options".
Windows Shell Commands

Your sequences can now be configured so that, whenever one is played, Light-O-Rama will execute
any arbitrary Windows command that you associate with that sequence.

An example of how this might be useful: If you broadcast the songs playing during your show over
the radio, and have hardware allowing you to broadcast RDS ("Radio Data System") information, you
can now set your sequences up so that, whenewer one is played, Light-O-Rama will tell Windows to
tell your RDS program to broadcast the name of the song for that sequence.

For details, please see the help file page "Windows Shell Commands".

DMX Intensity
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A new effect, "DMX Intensity", has been added. This can be used to specify 256 possible
intensities (from 0 to 255), rather than the regular 101 possible intensities (from 0 to 100). This is
useful for DMX devices, which can take up to 256 possible intensities.

Note: The DMX intensity tool is not available by default in the Sequence Editor - for example, by
default, no toolbar button will be displayed for it. To enable the tool, select "Allow DMX Editing" from
the DMX Preferences menu.

The New and Open Dialog

The Sequence Editor's new "New and Open dialog" allows you to create a new seguence, or open
an existing one. This dialog is opened by default when the Sequence Editor starts up (although this

behavior can be suppressed), and also when something like "New" or "Open" is selected from the
File menu or the Standard toolbar.

Keep Lights On at End of Play

For most sections in a show, you can now use the Show Editor to specify whether or not sequences
in that section will automatically turn their lights off when they end playing.

There are two exceptions: First, the Background section does not allow this setting. Second, the
Interactive section allows you to control this for each interactive group individually, rather than for the
section as a whole.

Automatic Channel Settings for Newly Created Sequences

When creating a new musical sequence or new animation sequence, you now have the option to
automatically configure the channels in the new sequence to use standard Light-O-Rama controllers
. The first channel will be set up to use Light-O-Rama unit 1 circuit 1, the next unit 1 circuit 2, and
so forth, then on to unit 2, and so forth. All such channels will be configured to use the regular LOR
network.

Events Can Be Dragged with Timings

When a timing is dragged in the Sequence Editor, to change the time it is at, there is now an option
to also drag any effect events that start or end at that timing along with it.

This option is controlled via the Edit menu's "Drag Events with Timings" checkbox.

Change in Behavior for Mouse Switching Tracks
Switching to another track via the mouse in the Sequence Editor now causes the selected area for
that track to be set to the cell that was clicked, even if that cell is within what used to be the

selected area for that track. In particular, if a tool other than "Select" is enabled, that tool will be
applied to the new selection, not the old one.

Animation Sequences in Musical Section Cut Off at End of Show

In previous versions, when a show reached its scheduled end, if a sequence from the musical
section of the show happened to be playing, that sequence would continue playing to its natural end
before the shutdown section of the show would begin. Now, that is only the case for musical
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sequences; if the sequence is an animation sequence, it will abruptly stop at the scheduled end of
show, regardless of the fact that it is in the musical section of the show.

"Max Units" in Hardware Utility Changed to "Max Unit ID"

When the Hardware Utility is asked to automatically detect units, it must individually search for each
possible unit ID. This may take some time to do. To speed this up, the Hardware Utility allowed
you to specify a maximum number of units to search for, in a box labelled "Max Units". For
example, if you set "Max Units" to "3", the Hardware Utility would search for a controller with unit ID
01, another with unit ID 02, and a third with unit ID 03. It would not check for any unit IDs past 03.
Howewer, this often led to the following confusion:

Unit IDs are given in hexadecimal notation. So, for example, the next unit ID after 09 is not 10, but
OA. That is followed by 0B, OC, 0D, OE, and OF, and only then does 10 come. So, if a person's
highest unit ID was 10, they might be mislead to thinking that they should input "10" into "Max
Units". But "Max Units" was merely a count, not an ID, meaning that the Hardware Utility would
only search for the first ten possible unit IDs, i.e. 01 through 09 and OA. Therefore, unit 10 would not
be found (as it is actually the sixteenth possible unit ID).

To get rid of this common source of confusion, "Max Units" was changed to "Max Unit ID". So now,
for example, entering "10" will search for unit IDs 01 through 09, unit IDs OA through OF, and unit ID
10.

Bug Fixes
This release fixes the following issues:

o If the Play Again button on the Standard Toolbar of the Sequence Editor were hit quickly two
times in succession, an error message box would appear.

e If the "turn a channel on and off" feature of the VU Wizard were used on only part of a musical
sequence, it would correctly turn the channel on and off in that part, but would additionally turn
everything in the channel past that part off.

¢ In certain situations, when scrolling through tracks in the Sequence Editor, the track bar for some
tracks would not be displayed, and instead part of the previously displayed channel grid would be
displayed where the track bar should have been.

e [f certain Light-O-Rama entries in the Windows registry were mistakenly deleted (for example, by
a third-party registry cleaning program), and a musical sequence were modified and saved, the
name of the sequence's media file would not be saved along with it, and you would be unable to
modify the sequence again to tell it the name of the media file. This effectively means that the
musical sequence would be "transformed" into an animation sequence. This no longer occurs.
Note, though, that Light-O-Rama still might not be able to play the sequence, as those registry
entries tell it where to look for media files. But after the issue with registry is corrected, Light-O-
Rama will now play those musical sequences as normal.

¢ If a sequence had a channel that was set up to be a Light-O-Rama controller, but did not have its
unit ID set, that sequence would not play in the Show Player.

e Removing a channel that was in more than one track from a track would not cause the sequence
to be marked as having unsaved changes.

o If paste by cell is enabled, and effect events copied from a larger cell are pasted to a smaller cell,
those events are "shrunk” to fit into the smaller cell. If such an event had to be shrunk to less
than a centisecond in length, pasting would fail, giving an error message "Start time cannot be
less than end time". Now, events shrunk to less than a centisecond are simply skipped when
pasting.

e When creating an SD card for an MP3 Director, a valid COM port is no longer required.
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¢ Some machines were having problems downloading standalone sequences to controllers. The
reliability of downloading has now been improved.

e When setting a unit ID via the Hardware Utility, the dropdown boxes allowing you to select a unit
1D only show unit IDs from 01 up to the unit ID specified in the Hardware Utility's "Max Unit ID"
setting. Previously, though, changing "Max Unit ID" would not change the values listed in the
dropdown boxes, until the Hardware Utility was closed and then restarted. Now, the new values

will be available immediately, without needing to close and restart.

What's New in Version 2.0.16

The following changes were made for Light-O-Rama version 2.0.16:

e Simple Show Builder updated
e Bug fixes

Simple Show Builder Updated

Previous releases of Light-O-Rama version 2 included the same Simple Show Builder as was used
in Light-O-Rama version 1. It therefore could not be used with sequences that were created using

the version 2 Sequence Editor.

Simple Show Builder has now been updated so that it can be used with sequences that were
created using either version 1 or version 2.

Bug Fixes
This release fixes the following issues:

e Various tools such as the Beat Wizard, VU Wizard, and Waveform Display had problems with
certain audio files, resulting in an error message saying "Can' init conversion" appearing, after
which these tools would be unusable with those files. This release fixes this issue (at least in the
known situations that it happened in).

e The Beat Wizard would crash when used with certain audio files on some customers' machines.

o |f either "Close All Files" or "Close All Files Except This" was used, and one of the sequences
being closed had its Animator window open, an error message would pop up saying "Error
Loading Animation Form".

What's New in Version 2.0.14

The following changes were made for Light-O-Rama wversion 2.0.14:

New play ranges

Freeform play mode

Space Bar to play: enter to apply tool
Subdividing cells

Skewing tracks

Waveform height

Waveform display modes

Wavweform colors

Bug fixes

New Play Ranges
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Two new play ranges have been added to the Sequence Editor: "From Selection” plays from the
start of the selection to the end of the sequence, and "To Selection" plays from the start of the
sequence to the end of the selection.

Freeform Play Mode

You can now use the keyboard to select an arbitrary time range for future playing. Please see "
Freeform Play Mode" for details.

Space Bar To Play; Enter To Apply Tool

In the Sequence Editor, the space bar can now be used to start a sequence playing, and then to
stop it. If a freeform play range has been selected, that range will be played; otherwise, play will be
in "from selection” mode - that is, it will start at the start of the current selection, and go until the
end of the sequence. This can be used to effectively pause and unpause play.

In previous versions of Light-O-Rama, the space bar was used to apply the current effect tool to the
selected cells. That is now done using the enter key instead.

Subdividing Cells

The Sequence Editor can now subdivide the selected cell or cells into a new number of cells (which
you select). Each cell is subdivided into the specified number of cells, and all of the new cells within
any particular old cell will be of the same length (or as close to the same length as possible).

For example, if you select two cells, the first from 3 seconds to 7 seconds, and the second from 7
seconds to 7.5 seconds, and ask the Sequence Editor to subdivide them into two cells each, you
will wind up with four cells: From 3 to 5, from 5 to 7, from 7 to 7.25, and from 7.25 to 7.5.

This can be done via "Subdivide Timings" on the Timings submenu of the Edit menu, or via "
Subdivide Timings" on the right-click context menu.

Skewing Tracks
The Edit menu of the Sequence Editor now has a new menu item, "Skew Track". This lets you

movwe all of a track's events, timings, and loops by a specified amount of time, either to the left (i.e.
earlier in time) or to the right (i.e. later in time).

Waveform Height
In previous ersions of Light-O-Rama, the waveform of a musical sequence was either displayed or
not. Now, if it is displayed, it can be displayed at two different heights: full height and half height.
Full height is the same as the height that was used in previous versions of Light-O-Rama.

Half height and full height (and "off") can be selected from the Wave Form submenu of the View
menu.

Waveform Display Modes

The waveform of a musical sequence can now be displayed in three different ways: "full mode",
showing zero wlume at the center and loud volumes above and below it; "fold mode", showing zero
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at the bottom and folding the two halves of full mode onto the top; "top mode", showing zero at the
bottom and the top half of full mode abowe it. "Full mode" is the same as the way the waveform was
always displayed in previous versions of Light-O-Rama.

To set the display mode, right-click on the waveform, and select the desired mode from the listed
choices in the popup menu.

Waveform Colors

The colors used to display the waveform of a musical sequence are now configurable. To choose
new colors, right-click on the waveform, and select "Change Colors" from the popup menu.

Bug Fixes
This release fixes the following issues:

¢ In the Channel Property Grid, if a channel was set up with a device type but no unit number and/or
circuit number, it might later be displayed (in both the Channel Property Grid and the Channel
Settings dialog) as if it had a unit number and/or circuit number set (although it still did not).

e When printing from the Channel Property Grid, unit numbers of some Light-O-Rama controllers
would be mislabelled, as would device types of certain non-Light-O-Rama controllers.

¢ If a sequence was changed, but not yet saved, and "Revert to Saved" was selected from the Eile
menu, the sequence would be properly reloaded, but could not be played again until it was closed
and reopened.

e Sevweral dialog windows had a problem where, if the dialog was closed by hitting the enter key
rather than by clicking the OK button, changes to the last field modified might not be acted upon.

¢ If a channel was in two or more tracks, and had a shimmer effect, the effect would not be
displayed properly in the Animator.

¢ If a sequence was playing in the Sequence Editor, and some other sequence was not playing but
had its Animator open, clicking on that Animator's play button would set off a string of errors.
Now, instead, it simply does not start play (while the other sequence is playing).

¢ A problem with undoing and redoing changes in sequences with loops was fixed.

o Highlight Current Event on the Play menu is supposed to control whether or not the current event
is displayed with a thick border (as if it were the selection) during play. It did so, but it also
mistakenly controlled whether the selection was displayed or not while play was not happening.

¢ If a musical sequence’'s media file did not hawe its "Ready for Archiving" flag turned on (in the file's
properties in Windows Explorer), the Sequence Editor would not play the sequence, complaining
that the media file could not be found.

¢ If the Sequence Editor played a musical sequence at quarter, half, double or quadruple speed, and
the directory its media file was in contained a period in its name, sometimes the wrong media file
would be played.

What's New in Version 2.0.12

This release fixes the following issues:

¢ A show would pause indefinitely if the Show Player was asked to play a musical sequence whose
media file was missing.

¢ Musical sequences played during the startup and shutdown sections of a show would control the
lights, but would not play audio.

¢ Commands for X10 channels were often getting lost.
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What's New in Version 2.0.8

This release contains the following bug fixes:

e The Tapper Wizard's dropdown list allowing you to select the track to use did not work properly,
leading to the taps being put into whatever track had been selected at the time that the Tapper
Wizard was opened, rather than into the one that was selected in the list.

e The VU Wizard's option to operate on only a portion of the song, as opposed to the entire song,
did not work properly.

e Importing channel configuration into a sequence did not mark that sequence as having unsaved
changes.

e Communication with the controllers is kept alive during the loading of sequences. This is to fix an
issue where, after the loading of a large sequence, the PC would have to resynchronize with the
controllers due to communication having been paused. This resynchronization could have taken
some time, causing strange effects immediately after synchronization.

e If an error occurs while communicating with the controllers, Light-O-Rama tries to reestablish
communications, in the hopes that the error was merely a temporary glitch. Howewer, for certain
types of errors, it would not try to do so, leading to the communications being permanently down.

What's New in Version 2.0.4

Version 2.0.4 fixes a bug where X10 channels were not being controlled during shows.

What's New in Version 2.0.0

The following new features, changes, and fixes have been made for Light-O-Rama version 2.0.0:

Tracks

Sequence-in-sequence play
Background and foreground effects
Universal undo and redo

Channel positioning

Mouse scroll wheel support

Pasting timings between sequences
Video playback

Intensity and fade presets
The Beat Wizard

The VU Wizard

Recording of individual instruments in the MIDI Wizard
Multiple Light-O-Rama networks

More media support

Animator background image

The Channel Property Grid

Pasting effects: by time or by cell

Holiday Lights Designer support

XML sequence files

Microsoft Windows Vista support

Animator window CPU usage decreased
Animator's maximum rows and columns increased

Sequence Editor's keyboard support improved
New look for the shimmer effect

Channel settings form directly accessible via the channel's button
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¢ Bug fixes and internal improvements

Tracks

Previously, a sequence was composed of channels, loops, and timings. Now, instead, a sequence
is composed of tracks. Tracks, in turn, have channels, loops, and timings.

Two tracks in the same sequence can hawe different channels, or they can share channels with each
other. They have different sets of loops and timings than each other. In an animation sequence,
tracks can be of different lengths than each other.

¥ Bushes. las

Track 1: Tenth Second Timings
390

Time Scale ||||||||1|'=]rTI|||||||2|'m-TI|||||||

Bushes [Green §§ §§ 3%
Bushes (Red §§% §§g §

1| | »
Track 2: Half Second Timings
Time Scale ||||||||1|'=]I{I|||||||:|Z'I]I{I|||||||$'I][|I|||||||i|1'u[|lll
Buzhes [Green) §
Bushes (Red] S
1 [

Two tracks, with the same channels, in one sequence
A brief example of how this may be useful:

In a musical sequence, you may want to have some timings representing a bass drum, other
timings representing a guitar, and yet another representing something totally unrelated to the song.
Before tracks, in Light-O-Rama version 1, you could add all of these timings to your sequence, but it
might be difficult to remember, while building the sequence, which timings were for which purpose.
The more unrelated timings that you added to the sequence, the more confusing the sequence as a
whole would become.

Now in Light-O-Rama version 2, instead, you can build a single sequence with multiple separate
tracks, each with only one of those sets of timings, making each set of timings cleaner and simpler
to understand. Plus, you can share channels between two or more tracks, have different channels
in different tracks, or both.

Sequences are initially created with a single track. Another track can be added \ia the Edit menu's
"Add New Track" or "Duplicate Track" items (the latter of which will share all channels in the current
track with the new track), or via new items on the channel buttons' popup menus ("Copy to New
Track™ and "Move to New Track").

To share an individual channel between multiple tracks, do not simply set two different channels to
use the same unit number, circuit number, et cetera, as this will likely have unexpected and
undesired results. Instead, use the "Copy to New Track" or "Copy to Track Number ..." function on
the channel's popup menu:
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Bushes [Fer” §§ §§ m
Change Mame
N I Change Color - —
Change Channel Settings 2econd Timings
Time Scale I 2||][|| BEREEN El”'"{l I
Insert Channel Above
Bushes [Gree  1root Channel Below §
Bushes [Rer  Insert Multiple Channels Abave 3%
- Insert Multiple Channels Below

Delete Channel
Remove Channel From Track

Copy ko Wew Track,

Movve Copy ko Track Mumber ...

Share a channel with another track by copying it to the other track

If a sequence has more than one track, the tracks are separated in the display by a track bar,
labelled (for example) "Track 1" or "Track 2". If the track has been given a name, it will also be
displayed here (for example, "Track 2: Front Yard Mini-trees"). Clicking on this bar gives a popup
menu containing various track-related items:

Change Track Mame

Time Scale

Bushes [Green] Mowve Track Up

Buzhes [Fed] Mowve Track Down
N I I Insert Track Above
Track 2 Snowman
. 1.00 Insert Track Below
Time Scale R

Showman [Epes) Duplicate Track

Change Total Tirme
Delete Track
Hide Track

Showrman [Pipe]

Click on atrack bar for various track-related menu items

Sequence-in-Sequence Play

A channel in a sequence can now be set to represent another sequence (rather than representing a
physical circuit), known as a "subsequence". This is done in the Channel Settings dialog, by
changing the "Device Type" to "Sequence" (rather than to "Light-O-Rama Controller", "Digital 10
Card", or so forth), and choosing the filename of the sequence in the "Sequence" box:
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¥ Channel Settings f5__<|
MHame |Bushes Animation
Color
Device Type
| =
| =
| =
Seguence |Eushes.las J

k. Cancel |

Channel settings for sequence-in-sequence play

A subsequence will play only when the channel that it is a subsequence of is turned on, and will
continue playing as long as the channel is on. If the channel is turned off and then turned back on,
the subsequence will start over from its beginning.

TIP: Don't try to control the same physical circuit with both a channel in a subsequence and a

channel in the main sequence. Doing so will probably cause unexpected results, as the two
channels will vie for control of the circuit.

Background and Foreground Effects

Turning on background effects or foreground effects in the Sequence Editor will affect the behavior of
tools (such as "Fade Up", "Twinkle", "Set Intensity", et cetera) in the following manner:

If "Background Effects" has been turned on, the tool only applies to those selected cells that are
completely off (that is, at intensity zero for their entire duration).

If "Foreground Effects” has been turned on, the tool only applies to those selected cells that are not
completely off.

Some examples:
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¥ (new sequence 2)*

Time Scale

1.00
!

Channel 1

Channel 2

Channel 3

Channel 4

Before a background fade up

¥ (new sequence 2)*
Tirme Scale

Channel 1

Channel 2

Channel 3

Channel 4

After abackground fade up

¥ (new sequence 2)*

Time Scale TR

Channel 1

Channel 2

Channel 3

Channel 4

Before aforeground fade up

¥ (new sequence 2)*

Time Scale 1.00

RN RN
Channel 1

Channel 2

Channel 3

Channel 4

After aforeground fade up
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Universal Undo and Redo

The Seguence Editor's undo and redo used to only work for the effect tools (such as "on", "off", "fade
up", "twinkle", and so forth). You can now undo and redo a much wider variety of things - adding

channels, moving timings, changing loops, drawing in the Animator, and many others.

¥ Light-0-Rama Sequence Editor v2.0.0
File Ma&l® wiew Tools Play  Window Help
[l Undo Delete Channel Ckrl+2 ﬂ

CErl+-Y

ok el ﬂ
Examples of things that can be undone and redone

Channel Positioning

Channels can now be moved up and down in the Sequence Editor. There are two ways to do this:
First, the channel buttons' right-click popup menu now includes "Move Up" and "Move Down", which

will move the channel by one spot. Second, a channel button can how be mouse dragged to a new
position.

Mouse Scroll Wheel Support

The mouse scroll wheel now works in the Sequence Editor. Scrolling with the wheel causes the
displayed channels in the active sequence to scroll.

Pasting Timings between Sequences

Previously, timing ranges copied from a sequence could only be pasted into that same sequence.
Now, a timing range copied from one sequence can be pasted into a different sequence.

Video Playback

The Show Player and the Sequence Editor can now use video files (in addition to the previously
available audio files) to create sequences. The video output can be displayed during play.

In the Sequence Editor's Edit/Preferences menu, there is now a new item called "Video Preferences
", which gives control over how video files will be used (both in the Sequence Editor and during
scheduled shows):
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® Video Preferences K (= [B)(X]

[ Dizplay Audio Yizualizations
[ Use Full Screen tMaode

Select Monitar

k. Cancel

Edit/Video Preferences

These options can also be temporarily changed in the Sequence Editor via the View/Video menu.
Howewer, changes made this way will only affect the Sequence Editor (not the Show Player), and
will only last during the current use of the Sequence Editor - that is, the next time that the Sequence
Editor is started, the video preferences as set in "Edit/Preferences/Video Preferences will be used
again).

¥ Light-0-Rama Sequence Editor v2.0.0
File Edit BUEESN Tools Play Window Help

P |@|I°_J W C.hannel Butkons u MEI@J

v Time Scale
% | B E| il

Animation

A

YWideo

Time Sc Fades » Sth .ﬂ.udu:u YWisualizations

Eull Screen
Sequence Info

Track Info
Channe

View/Video

Intensity and Fade Presets

The Sequence Editor's Set Intensity, Fade Up and Fade Down tools now have ten preset values (or
ranges). The old "Tool Options" dialog was replaced with the Fade Tool Settings and Intensity Tool
Settings dialogs to set these presets:

¥ Intensity Tool

Intenzity PP
e
a0

Intensity Settings, with 70% selected

© 2009 Light-O-Rama, Inc.



34

Light-O-Rama v2.4.10

Fade Diown (X -y F X R T
Fade Settings, with fade up 50-75% and fade down 100-0% selected

The Sequence Editor comes with default preset values (such as 10%, 20%, and so forth) build in; if
you want to change any of the presets, you can do so by clicking the settings tool's "EDIT" button:

¥ Intensity Options |E|

|ntenzity S ettings
Sethng 1 IT percent
Sefting2 |20  percent
Sefting3 [Ef  percent
Setting 4 W percent
Setting 5 W percent
Setting B Iﬁ percent
Sefting? |70 percent
Setting 5 W percent
Setting 3 W percent
Setting 10 100 percent
Fevert | Cancel | Accept

Changing an intensity preset to 37%

¥ Intensity Tool

Irtenzity

The preset has now been changed to 37%

The values of the presets for both intensities and fades can also automatically be set using Load
Intensities and Fades from Current Sequence, of the Tools menu. This will figure out the most

commonly used percentages for both intensities and fades existing in the current sequence, and set
the preset values to them.

The Beat Wizard
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The Sequence Editor's new Beat Wizard can be used to automatically analyze a song to try to
determine its beat, and to populate a musical sequence with timings or effects based upon that
beat. The Beat Wizard can be found in the Sequence Editor's Tools menu. It is also available as

one of the options for creating a new musical sequence, and for creating a new track.

¥ Beat Wizard

— Time Range

% The entire zong [0:00.00 to 4:47.90)
£ Just part of the song:

Erom: [r:00.00 To: [4:47.40 Update |

Light-0-F ama thinks thiz zong has about 177 beatz per minute in this time range.

— Tempo
' |se the detected tempo [177 beats per minute]
 Usze a fazter related bempo:

|21 Faster (354 BPM) =]

7 Use a slower related tempa:

IE:.: Slower (88 BPM) ;I with beat offzet: Iﬂ
— Preview
Start | [T T I [Time 0:00.00 7 4:47.90
- sl s "R

&

—What To Do with Beats
IJzing this track: ITTE"Ek 1 j

And theze timings:l ® [nnamed timing grid] j

Or add a new tirming grid: Mew Fived Grid | Mew Freeform Grid |

¥ |nzert a timing into the timing gnd far each beat
[~ Tum on a channel exvery =0 many beats:

ILlnit .1 j thiz many beats: |4 with beat offzet; ||:|

[T Snhap effects ta timings within |4 bundredths of a second

Apply and E it | Apply | E xit | | ue] | Hedo |

The Beat Wizard

The VU Wizard

The Sequence Editor's new YU Wizard is a VU meter-like tool that can be used to automatically
populate a musical sequence based upon peaks in the audio. The VU Wizard can be found in the
Sequence Editor's Tools menu, and is also available as one of the options for creating a new
musical sequence, and for creating a new track.

© 2009 Light-O-Rama, Inc.



36

Light-O-Rama v2.4.10

t VU Wizard

X]

— Time Range

% The entire zong [0:00.00 ta 4:47.90)
£ Just part of the song:

Erom: IEI:EIEI.EIEI To: |4:4?.EIEI Update I

—attack and Decay

.;ttagki ER.2 millisecnnds Update
Decay: |gg 2 millizeconds —I

Prezets: YU Meter PeaillF'ngrgm Peak beter
eter
— Peak Threshold
& Total | 1
 Left |
" Right |
— Presview

Start | I |Time: 0:00.00 / 4:47.90

—what Ta Do with Peaks

Llsitg this: track: ITfaCk 1

[

find these timings: I' [Unnamed timing grid)

Or add a new timing grid: Mew Fized Grid | M ew Freeform Grid |

¥ Inzert a timing into the rack whenever the peak threshold is crossed
[ Tun a channel on when above the threshold, and off when below:

[urit 01.1 =l

[T Snhap effects ta timings within |4 hundredths of a second

[

Apply and E it | Apply | E xit | Undo | Hedo |

The VU Wizard

Recording of Individual Instruments in the MIDI Wizard

The MIDI Wizard can now automatically create lighting effects for a musical sequence based on the

notes played by individual instruments in a MIDI file.
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¥ MIDI Wizand

Playback Contral

RECORD ‘ SANE ‘ 1. Choose which instrument you wish to record. ~
Flay | 2. Chooze how many channels you wizh to use. Faor each
[0:0041.02 channel zelected, one note will be recorded.  The notes
[ | | [ RECORDING CLEAR that will be recorded are marked ') they are the most 2

Effects Summary] Warious Effects  Individual Nates l

Channel Selection

24 channels are required far the
zelected effect.
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I~ Map Unsslected Mates by Octave |Llnit 024 ﬂ
Add One | {Add A Group |
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CCHDDHE F FH G GHA AH#E Selected Channels

Octawe-1[ [ [T [ T[T T T e 01 - Unit 02.4 A

Octawe O[T [ 04 EEEEEEEEEEEE 02 - Lnit 02.5

Octave 1 |1 NN DSOS | | | [ | | ||| i

Dictavve: 2 0 I D D 4 I N [TTTTrrrrrrrir- 0% - Uit 02.8

Octawe 3 ) D] [ [ [ T[T T [(TTTTTTIrrrrr 06 - Uit 01.1

Oteed [T TTTTT [(TTTITrrrrrrrir 07 - Unit 1.2

Octawe 5[ TTTTT [T (TTrrrir SSHQ:: S]i

Octaweb [ [ [T [ T[T T[T [TTTTTrrrrrrir- 10 Urit 015

Octave?[ T [ [T TTTTTTT (T TTTTrrrrri- 11 - Urit 0.5

Oetee8 [ [T T TTTTT [(TTTIrrrrrrrr 12 - Urit01.7

Oetave S [ [T [ [T TTTTTTTT HH::: g}g
15 - Unit 0110 v
Remove One Clear

The MIDI Wizard's can automatically create lighting effects based on the notes played in a MIDI file

Multiple Light-O-Rama Networks

Previously, only a single COM port could be used for Light-O-Rama controllers. Now, up to four
Light-O-Rama networks can be used simultaneously on the same computer, on different COM ports.

The same unit and circuit number can be used on multiple networks simultaneously and
independently, with different effects happening on the different networks.
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¥ Channel Settings

Marne |Ehannel 2

Color I
Device Type |Light-D-Hama Contraller j
Metwork. | Regular j
Lnit

CircLit A C

k. Cancel |

Up to four different networks can be used for LOR controllers

More Media Support

Various new media file types (including Windows Media Files and certain types of videos) are now

supported for musical sequences.
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7

Open Media File

Laok jr: | (£ Media | @ £% EE-
A ®aiing.af ) Aising.rmi
Lmﬁ B bisling. aifc B aisling. snd
MyFRecent | =) aisling. aiff Aisling. war
bigsumziis B hisling. asf E| Aislirg . wrn
@ B fisling. au s Aisling . wma
|| dislirg. avi || Asislirg v
Desktop || &isling. iy
. B disling. mid
'L--} &) disling. midi
|| &isling. mp2
kdy Documents A disling.mp3
— || &isling. mpa
%! || &isling. mpe
M_I,I.Ecumputer & Aisling. mpeg
|| &isling. mpg
My Metwark.  File name: | j Open |
Flaces
Files of bpe: |l Supparted Files -l Cancel

Various supported mediatypes

Animator Background Image

A sequence's animation can now be set up to have a background image, such as a picture of a

house on which Christmas lights are to be placed.
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® Animation for (new sequence 4)

Dirawming

" Draw
" Eraze
™+ Wiew

[Bea

Background Image

Select
Remove

[~ Simulate night time

The Animator, with abackground image
The Channel Property Grid

The Sequence Editor's new Channel Property Grid is a window showing information about all of the
channels in a sequence (their color, device type, unit number, et cetera), and allowing changes to
those properties in a (hopefully) convenient manner. This can be accessed via the Sequence
Editor's Tools menu.
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¥ Channel Properties
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X/ [Bumblebes Animation I [Ligh-0Rama Controlh =] [Regular 2 I (=R I EEE
X/ [Snowman Main) | [ligh-0-Rama Contrall =] [Reuiar 2 I R e EE
%] [Snowman (ms Up] | [tight-0-Rama Cortral ~|  [Regular 2 R e EE
ﬂ |Snowman [Armz Do) 4 |Light-D-Hama Eontmlhﬂ |Hegular j |D2 j |4 j |
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ﬂ |Snowman [Coal Eye #1) ! |Light-D-Hama Eontmlhﬂ |Hegular j |D2 j |? j [ |
X[ [Snowman (Caal Eye #2) B |Light-0-Rama Cortrol v | [Regular 2 R e EEE
%/ [Snowman (0id ik Hat] L | [light-0-Rama Controlh »]  [Reauiar 2 I R i R
X| [Front Trees [Fed) | [Light-0-Rama Cortroh ~ | [Regular 2 R e EEE
ﬂ |Fr0ntTlees [Bhae) ! |Light-D-Hama Eontmlhﬂ |Hegular j |l33 j |3 j |
X| [Fiont Trees [velow] __| [light-0-Rama Control =] [Reguiar R =R e CE
X| [Side Bushes (B] [Light-0-Rama Controlh »]  [Reguiar R R =l
Frint | Add Controller | Delete Controller | Add Channels | Cancel

The Channel Property Grid
Pasting Effects: By Time or By Cell
When pasting effects in the Sequence Editor, you can now choose to insert the events into the

destination based upon either the length of the copied events or else the relative lengths of the
copied and destination cells.

For example, consider timings at 0 seconds, 1 second, and 2 seconds. Between O and 1 is a fade
up, and between 1 and 2 is a fade down:

¥ (new sequence 5)*

1.0

Time Scale R EEE

Channel 1

0 2.00
[ o

Events to be copied

These events will be copied, and pasted to the time starting at 5 seconds. There are timings at 5
seconds, 7 seconds, and 7.5 seconds:

¥ (new sequence 5)*

Time Scale |5|'m{l|||||||l|5'=][|l|||||||:‘|r'm{||||||

Channel 1

Where they will be pasted to

If "Paste by Cell" is selected, then there will be a fade up from 5 to 7, and a fade down from 7 to 7.5
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(this is the same way that pasting always behaved in version 1 of Light-O-Rama):

¥ (new sequence 5)*

Tirne Scale 5.00 ||5=][|| ?I'[I[II

Frgprrrrrnriai | I T Y A I | [ Y I |

After pasting by cell

If "Paste by Time" is selected, then there will be a fade up from 5 to 6, and a fade down from 6 to 7.
The timings at 7 and 7.5 are ignored; only the original lengths of the events are used:

¥ (new sequence 5)*

Time Scale 5.00 Eliﬂ[|| i:'l]l{l

Channel 1

After pasting by time

You can switch between these two modes by selecting "Set Paste Mode" in the Sequence Editor's
Edit menu.

Holiday Lights Designer™ Support

Light-O-Rama can now interact with Holiday Lights Designer™, a third-party application by
Holidaysoft®.

Holiday Lights Designer™ can be used to virtually place lights and decorations on images of your
home or business, and Light-O-Rama can now send Holiday Lights Designer™ commands during
play to make those virtual lights behave as your real lights would during a show.

To send commands to Holiday Lights Designer™, first set the Holiday Lights Designer Preferences
in the Sequence Editor under the Edit menu. After this is done, commands can be sent from the
Sequence Editor by turning on "Control Holiday Lights Designer" in the Play menu, or from the Show
Player by selecting "Holiday Lights Designer On" in the Light-O-Rama Control Panel.

Version 4.0 or above of Holiday Lights Designer™ is required to take advantage of Light-O-Rama
interaction.

For more information about Holiday Lights Designer™, please see the Holidaysoft website.

XML Sequence Files

Sequence files (and channel configuration files) are now saved as XML files. LOR 2 understands
both these new sequence files and the old LOR 1 style sequence files.

If an LOR 1 file is modified and saved by LOR 2, it is automatically updated to the new LOR 2 style.
This means that LOR 1 will no longer understand the updated file. Howewer, to be safe, a copy of
the original LOR 1 sawe file is automatically created, and labelled as an LOR 1 file. For example, if
the LOR 1 sequence file "lights.las" is converted to an LOR 2 file, then a copy of the original LOR 1
file will be created, named "lights.las.vl.bak".
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Microsoft Windows Vista Support

Various changes were made to better support Light-O-Rama on the Microsoft Windows Vista
operating system.

Animator Window CPU Usage Decreased

The Sequence Editor's Animator window now uses significantly less CPU during play than it used
to.

Animator's Maximum Rows and Columns Increased

The Animator window now supports up to two hundred rows and columns:

¥ Animation for, (new sequence 5) nn |:||§||X|
4| »|m|
Size
Rows  [a00
Coumns  [200

Update

Zoom Lo

| S
Dirawing
Chatinel 2 j
~ Drawd
" Erase
T Wiew

Background Image

Select
_ e |

-

Animation with 200 rows and 200 columns
Sequence Editor's Keyboard Support Improved

Seweral changes were made to make using the keyboard easier in the Sequence Editor. For
example:
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New Look for the Shimmer Effect

The "enter" key now chooses the "OK" button on most forms;

The "escape" key now chooses the "Cancel" button on most forms;

The "tab" key circulates between controls in a more sane order;

Many Alt-key shortcuts were added to various forms;

The various menus were reorganized so as to cause less conflict among their various items'
shortcut hotkeys.

The shimmer effect is now drawn (in the Sequence Editor) using diagonal lines, instead of the
previous \ertical lines. This will hopefully make them stand out more against the background of
vertical lines which represent timings.

Note that this change is simply for display of the sequence in the Sequence Editor; the actual

appearance of the shimmer effect on controlled lights is unaffected by this.

Some channels with shimmer effects

Channel Settings Form Directly Accessible viathe Channel's Button

In the Sequence Editor, left-clicking and right-clicking on a channel button used to both bring up a
context menu of channel-related functions (such as adding, deleting, and moving channels). Right-
clicking still does that, but left-clicking now brings up the channel's settings form instead:

¥ Channel Settings

Mame

Calaor
Device Type
M etwark.
Unit

Circuit

| Toy Soldier's Cannon

OF.

Cancel
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The Channel Settings form

Bug Fixes and Internal Improvements
Seweral bug fixes have been made, including but not limited to the following:

¢ If a show includes a musical cleanup sequence, it is supposed to be played after each song.
Instead, it was being played only at the end of the show, just before the first shutdown
sequence.

¢ Some musical sequences, when played in the Sequence Editor, would reach the end of their
audio file, but would not cause the Sequence Editor to exit from play mode.

¢ Certain audio files would not play their audio.

e The Sequence Editor incorrectly determined the total length of certain audio files.

¢ When a musical sequence was played in the Sequence Editor using the "Visible Screen" play
range, the display would sometimes jump to an adjacent portion of the sequence, rather than
remaining on the initially visible portion of the sequence.

o Attempting to delete the first timing in a sequence (at time zero) would cause the Sequence
Editor to crash.

e Attempting to resize multiple timings (simultaneously) using the Sequence Editor's "Resize
Timings to ..." function (on the right-click popup menu) would cause the Sequence Editor to
crash if the sequence happened to be more than 5:27.67 long.

e When the Sequence Editor displayed fades using gradual changes in colors (as opposed to
when it displayed them using ramps), it would sometimes draw the end of a fade event past
where it should have been.

e The Tapper Wizard's option to not use a countdown before the song begins did not work.

¢ When a sequence was playing at a speed other than the normal speed (for example, through
the "Play Speed" menu item in the Sequence Editor, or due to a loop that was set up to
increase or decrease speed each time through), if a fade up or a fade down was done, the
lights would not properly take the speed of the sequence into account when determining how
quickly to fade. For example, a fade up from 0 to 100% that normally takes one second,
played at half speed, should fade up from 0 to 100% in two seconds. Instead, it would fade
up from 0 to 100% in the first second, and then remain at 100% for the entire second second.

¢ When the Cleanup or Delay portion of a show was modified in the Show Editor, the Save
button would not become enabled.

e The Sequence Editor's audio waveform display (and its positioning line) did not exactly match
up with the time of the rest of the display. This was especially noticeable at very high zoom
lewels.

¢ When moving a timing in a sequence by clicking and dragging it in the Sequence Editor,
sometimes the timing before the selected one would be mowed.

¢ When a musical sequence was opened in the Sequence Editor, and the "View Wawe Form by
Default" option was selected, if the sequence's audio file no longer existed (or otherwise could
not be opened), the Sequence Editor would crash.

¢ If a musical sequence was played in the Sequence Editor, and the sequence's audio file no
longer existed (or otherwise could not be opened), nothing would appear to happen. The
Sequence Editor now instead shows an error message box describing the problem.

Various internal improvements have been made as well.

What's New in Version 1.5.0

The following new features, changes, and fixes have been made for Light-O-Rama version 2.0.0:

e Tapper Wizard Behavior Change
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e Channel Deletion Fix
e Channel Button Feedback during Loops Fixed
e Animator Fix

Tapper Wizard Behavior Change

When the Tapper Wizard's "toggle" and "snap to existing events" options are used together, both
the beginning time and the end time of each toggle are snapped to existing events. This causes the
combination to behave in a way that is probably more similar to what most people would expect.

Channel Deletion Fix

Various problems occurred when the last channel in a sequence was deleted. These have been
fixed.

Channel Button Feedback during Loops Fixed

When the Sequence Editor was used to play a sequence with a Joop, and the end of the loop was
reached, just before going back to the beginning of the loop, the channel buttons' color displays
would sometimes briefly act upon the event just after the loop. This has been fixed. Note that it did
not affect the actual display of lights; it only affected the display within the Sequence Editor itself.

Animator Fix

If the Animator was sized so that scroll bars were necessary, the "draw" and "erase" functions
would act upon the wrong cells. This has been fixed.

What's New in Version 1.4.0

e Time Scale

e Copy and Paste Timings

e Animation Saved in Channel Configuration Export
¢ Right-Click in Animator Now Erases

e Duration in Status Bar

e Play Again

e Seweral Zoom Improvements

¢ Delete Selected Events

e Animator Efficiency

e Manual Stop Stays in Position

e Program's Main Window Remembers Its Position
e Bug Fixes and Internal Improvements

Time Scale

In the Sequence Editor, at the top of each sequence, a time scale is optionally displayed. Also,
during play, the button to the left of this scale now displays the current time offset.

Whether the time scale is displayed or not for any particular sequence can be controlled via the
View menu, or via a button on the toolbar. It can be turned on or off by default using the Display
Preferences dialog on the Edit menu.

Copy and Paste Timings
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In the Sequence Editor, you can now copy and paste timings - that is, make new cells having the
same duration and relative positions as some existing timings.

To copy a set of timings, select the range of cells that you want to copy, and then copy them in one
of three ways:

¢ Select "Copy Timing" from the Edit menu;

e Select "Copy Timing" from the right-click context menu;
e Using the keyboard, hold the "Shift" key and simultaneously hit the "Delete" (or "Del") key.

Once these timings are copied, you can paste them in one of several ways:

¢ Via the right-click context menu:
e "Paste timing at (the centisecond that was right-clicked)";
e "Paste timing at ...", which brings up a dialog box asking the centisecond to paste to
(defaulting to the centisecond that was right-clicked");
¢ "Paste timing multiple", which is similar, but also asks how many times you would like to
paste the timings consecutively, or if you wish to keep pasting them all the way to the
end of the file.
¢ Via the Edit menu, using "Paste Timing". This is the same as the right-click menu's "Paste
timing multiple", except that the starting centisecond defaults to the start of the current
selection, rather than the right-clicked centisecond.
¢ Using the keyboard, hold the "Shift" key and simultaneously hit the "Insert" (or "Ins") key.
This is the same as "Paste Timing" from the Edit menu.

Animation Saved in Channel Configuration Export
When a sequence's channel configuration is saved (using "Export Channel Configuration" from the
Edit menu of the Sequence Editor), the sequence's animation is saved along with it. When the
channel configuration is later imported into another sequence (using "Import Channel Configuration”
from the same menu), the user is given the option to import the animation as well.

Right-Click in Animator Now Erases
The right mouse button can now be used to erase cells in the Animator.

Duration in Status Bar

The status bar along the bottom of the Sequence Editor now shows not only the total time and
selected time range, but also the duration of the selected time range.

Play Again

You can now tell the Sequence Editor to "play again”. This causes it to play the last thing that you
asked it to play, regardless of the current play settings. For example, if you choose a certain time
range, with the play range set to "Selection"”, the Sequence Editor will play that selection. After play
ends, you may fix some problem that you noticed, which causes the selected time range to change.
If you wanted to play the same time range again, previously, you would have to re-select that time
range. Now, you can instead simply hit "Play Again".

There are two ways to do this: Via the "Play Again" item of the Play menu, and via a new toolbar
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button.

Several Zoom Improvements
Seweral zoom improvements have been made in the Sequence Editor:

e The "Zoom In" and "Zoom Out" buttons on the toolbar have been replaced by individual
buttons for "Zoom Channels In", "Zoom Channels Out", "Zoom Time In", and "Zoom Time
Out".

¢ Preferred zoom settings can now be saved or restored via the Zoom Preferences dialog on
the Edit menu. The saved zoom preferences are used by default when opening or creating
new sequences.

¢ Keyboard shortcuts now exist to zoom in various directions: Alt-Up and Alt-Down to zoom
channels in and out, and Alt-Left and Alt-Right to zoom time in and out. Also, Alt-Page-Up
and Alt-Page-Down to go to the minimum or maximum channel zoom settings, and Alt-Home
and Alt-End for the minimum and maximum time zoom settings.

Delete Selected Timings

In the Sequence Editor, several timings can now be deleted at once, by selecting a range of timings
and choosing "Delete Selected Timings" from the right-click context menu.

Animator Efficiency

The Animator has been made more efficient, using less CPU during play. This improves the
jerkiness that was seen on some machines during play while the Animator window was open.

Manual Stop Stays in Position
When you manually stop play of a sequence (as opposed to letting it stop by reaching its natural
end), the Sequence Editor now continues to display the screen that was being displayed when play
was stopped.

Program's Main Window Remembers Its Position

When you start the Sequence Editor, its main window is how opened in the same position that it
was in the last time it was closed.

Bug Fixes, Internal Improvements

Sevweral bug fixes and internal improvements have been made.

Feature Comparison

The Light-O-Rama software package must be registered, with a valid license, in order to be used to its
full potential. Seweral different license lewvels exist, each having different features: Basic, Basic Plus,
Standard, and Advanced. Additionally, there is an unlicensed Demo version (which is the same as the
Basic version, except that it cannot be used to actually control lights).

You will be given a chance to register your Light-O-Rama software at the time that you install it. To
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register after that time, or to upgrade to a higher level license, please see the "Register Light-O-Rama
" (or "Upgrade Light-O-Rama") menu item on the Sequence Editor's Help menu, or on the Control

Panel's popup menu.

The following chart summarizes what features are available with each license level, with detail on each
coming after the chart.

If a feature is listed as "(demo mode)", it means that the feature can be used with this license to see
what it's like, but it won't be fully supported. For example, if you try one of the Sequence Editor's demo
mode features while building a sequence, you won't be able to save your changes to that sequence.
Please see the details for each feature for exactly what "demo mode" means for that feature.

Any features not listed here are available with all license levels.

FEATURE DEMO BASIC BASIC PLUS | STANDARD | ADVANCED
Number of LOR 0 2 4 8 UNLIMITED
Units Supported

Number of Tracks 2 > 2 4 UNLIMITED

Supported

Beat Wizard (demo mode) (demo mode) YES YES YES
VU Wizard (demo mode) (demo mode) YES YES YES
Video Playback
(Windowed No No YES YES YES
Mode)
Full Access XML No No YES YES YES
Data Storage
Schedule Shows
Based on Day of | (demo mode) (demo mode) YES YES YES
Year
Startup
Sequencesin (demo mode) (demo mode) (demo mode) YES YES
Shows
Shutdown
Sequencesin (demo mode) (demo mode) (demo mode) YES YES
Shows
Background
Sequencesin (demo mode) (demo mode) (demo mode) YES YES
Shows
Sequence in (demo mode) (demo mode) (demo mode) |(demo mode) YES
Seqguence
MIDI Wizard (demo mode) (demo mode) (demo mode) |(demo mode) YES
Triggered
Interactive (demo mode) (demo mode) (demo mode) |(demo mode) YES
Sequences
Show Startup No No No No YES
Options
Execute Windows
Shell Commands No No No No VES
Full Screen Video No No No No YES
Playback
Multiple Networks No No No No YES
DMX Intensity No No No No YES
Dasher No No No No YES
Controllers
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FEATURE DEMO BASIC BASIC PLUS | STANDARD | ADVANCED
Supported
X10 Controllers No No No No YES
Supported
Digital 10 Cards No No No No YES
Supported
BSOFT Digital 10
No No No No YES
Cards Supported

Number of LOR Units Supported

Except for the Advanced license level (which supports an unlimited number of Light-O-Rama
controllers), each license level will send lighting commands to a limited number of Light-O-Rama
controllers: Basic supports a single controller, Basic Plus supports four, and Standard supports
eight.

Whether a particular controller is supported or not depends on its unit ID. For example, the Basic
license level will send lighting commands only to unit ID numbers 1 and 2, while the Standard
license level will send lighting commands to any unit that has a unit ID between 1 and 8.

Regardless of whether a particular unit will be sent lighting commands, you can always use the
Sequence Editor to build sequences using that unit; Light-O-Rama simply will not control the lights
for that unit unless you upgrade to a higher license leel.

The unlicensed Demo version will not send lighting commands to any controllers, so you cannot use
it to actually control your lights.

Number of Tracks Supported

A sequence may have multiple tracks; however, certain license lewvels will only support a limited
number of tracks in any given sequence. The Demo, Basic, and Basic Plus lewels support two
tracks per sequence, Standard supports four, and Advanced supports an unlimited number of tracks
per sequence.

You will not be able to add new tracks to a sequence if it already has the maximum supported
number. Howewer, you can still open sequences that have more tracks (for example, a sequence
that was created by someone who has a higher license level than you do). In this case, the extra
tracks will be displayed in the Sequence Editor, but you will not be able to modify them, and any
lighting effects in those tracks' channels will not actually control your lights during play.

Beat Wizard

The Beat Wizard can be used to analyze a song to try to determine its tempo, and to automatically
place timings and lighting effects into a sequence based upon that tempo. It is fully supported in
license lewels Basic Plus, Standard, and Advanced.

It is not supported in license level Basic (nor in the unlicensed Demo version). However, you can
still try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be
able to save your changes. You will be given a warning about this when you try it, along with a
chance to back out before committing to using it. Additionally, if you do decide to use it, and your
sequence already has unsaved changes, you will be given a chance to save them before you
actually use this feature.
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VU Wizard

The VU Wizard can be used to analyze a song to find peaks in the audio - much like a VU meter -

and to automatically place timings and lighting effects into a sequence based upon those peaks. It
is fully supported in license lewvels Basic Plus, Standard, and Advanced.

It is not supported in license level Basic (nor in the unlicensed Demo version). However, you can
still try it out in a "demo mode" to see what it is like; after trying it on a sequence, you will not be
able to save your changes. You will be given a warning about this when you try it, along with a
chance to back out before committing to using it. Additionally, if you do decide to use it, and your
sequence already has unsaved changes, you will be given a chance to save them before you
actually use this feature.

Video Playback (Windowed Mode)

You can build musical sequences based on audio files (such as MP3) or on video files (such as
WMV). When a musical sequence is played, the sound will always play, but the actual video (or
audio visualization) will only be displayed for license lewels Basic Plus, Standard, and Advanced.
License level Basic will not display video (or audio visualization).

Additionally, your license level may or may not support video playback in full screen mode; see "Eull
Screen Video Playback™ for details.

Full Access XML Data Storage

When a sequence is saved using license level Basic Plus, Standard, or Advanced, its sawe file uses
the standard XML format, which is designed to be understandable by people. Technically advanced
users may feel comfortable editing these XML-based sequence files directly with a text editor, or
even building their own tools that can be used with these files (although please be careful when
doing so, as it is not terribly difficult to make a small mistake which may render the sequence file
incomprehensible to the Light-O-Rama software package).

On the other hand, when a sequence is saved using the Basic license lewel (or using the unlicensed
Demo wersion), it is saved encrypted, and so the file itself cannot be easily understood or modified
by anyone or anything except the Light-O-Rama software package.

No matter whether a sequence is saved using the open XML format or using encryption, the Light-O-
Rama software itself will still be able to use it.

Schedule Shows Based on Day of Year

The Light-O-Rama Schedule Editor can be used to schedule shows to play in two different ways: by

the day of the week (such as "from 6:00 PM to 9:00 PM on Friday") or by the day of the year (such
as "from 9:00 AM to 9:00 PM on December 25th").

Howewer, scheduling based on the day of the year is fully supported only in license levels Basic
Plus, Standard, and Advanced.

Using the Basic license lewel, you will still be able to use the Schedule Editor based on the day of
the year in a sort of "demo mode" to see what it is like, but the Light-O-Rama Show Player will not
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actually play shows that are scheduled this way - it will only play shows that were scheduled by the
day of the week.

Startup Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Startup Section. Sequences in the Startup Section are played immediately upon the
show starting up, one at a time, in order. After all of them have been played, the main portion of the
show (i.e. the Animation Section and the Musical Section) begins.

Howe\er, this section is fully supported only with the Standard and Advanced license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Startup section; instead, the show will simply begin
play directly with the Animation Section and the Musical Section.

Shutdown Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Shutdown Section. When the scheduled end time for the show is reached, the main
portion of the show (the Animation Section and the Musical Section) stops, and the sequences in
the Shutdown Section are then played, one at a time, in order. After they have all finished, the show
is truly finished.

However, this section is fully supported only with the Standard and Advanced license lewels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode", to see what it is like. However, the Light-O-Rama Show Player will
not actually play the sequences in a show's Shutdown section; instead, when the scheduled end
time for the show is reached, the Animation Section and the Musical section will stop, and the show
will be ower.

Background Sequences in Shows

The Light-O-Rama Show Editor can be used to build shows with several different sections. Among
these is the Background Section. All sequences in the Background Section will play

simultaneously, looping back to their starts when they reach their ends, throughout the entire course
of the show.

Howewer, this section is fully supported only with the Standard and Advanced license lewvels.

Using the Basic and Basic Plus license lewels, you will still be able to use this section in the Show
Editor in a sort of "demo mode”, to see what it is like. Howewer, the Light-O-Rama Show Player will
not actually play the sequences in a show's Background Section.

Sequence in Sequence

Sequences can themselves contain subsequences - a parent sequence containing a child
sequence. The parent sequence can be set to start or stop the child sequence at any given point
during play.
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Howewer, subsequences are only fully supported with the Advanced license level.

Using other license lewels, you will still be able to use subsequences in a sort of "demo mode", to
see what they are like, but you will not be able to save changes to your sequence after having done
so.

MIDI Wizard

The MIDI Wizard can be used to automatically insert timings and lighting effects into a musical
sequence that is based upon a MIDI song. For example, it can make your lights chase each other
in time to the music, or turn certain channels on or off based upon what notes are being played.

Howeer, the MIDI Wizard is fully supported only with the Advanced license level.

Using other license lewels, you will still be able to use the MIDI Wizard in a sort of "demo mode", to
see what it is like, but you will not be able to save changes to your sequence after having done so.

Execute Windows Shell Commands

Using the Advanced license lewel, Light-O-Rama can optionally tell Windows to execute any
arbitrary command that you specify when a particular sequence is started. An example of how this
might be used: If you broadcast the songs playing during your show owver the radio, you might set
your sequences up so that they tell Windows to tell your RDS ("Radio Data System") program to
also broadcast the name of the song, allowing people with RDS-enabled radios to see the name of
the song currently playing in your show.

Triggered Interactive Sequences

In addition to being able to control lights, some Light-O-Rama controllers can also accept input,
acting as triggers to start particular sequences on demand during a show. For example, as part of
your display, you could have several buttons for people to push, each of which will play a particular
song.

Howewer, this feature is fully supported only with the Advanced license level.

Using other license levels, you will still be able to use this section in the Show Editor in a sort of
"demo mode", to see what it is like. Howewer, the Light-O-Rama Show Player will not actually play
any sequences which are triggered during your show.

Show Startup Options

Normally, the sequences in a show will start playing immediately at the show's scheduled start
time. The Advanced license lewel allows more control over this; for example, you could hook a big
red button labeled "Start the Show" up to one of your Light-O-Rama controllers, and the show will
not start until that button is pushed.

For details, please see "Show Startup Options".

Full Screen Video Playback
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When a musical sequence is based upon a video file (such as a WMV file), the Advanced license
level can show the video in full screen mode (and similarly, it can show full screen audio
visualizations for musical sequences based upon audio files).

Lower license lewvels cannot show full screen video (or full screen audio visualizations), but they may
still be able to show video and \isualizations in a window instead of in full screen. See Video

Playback (Windowed Mode) for details.
Multiple Networks

The Light-O-Rama Software Package can send lighting commands to Light-O-Rama controllers over
up to four Comm ports simultaneously. This has several potential uses, especially for people with
large numbers of controllers, or lights spread out physically far from each other.

Howe\er, this is supported only in the Advanced license level. Other license levels will send lighting
commands to Light-O-Rama controllers only over a single Comm port.

DMX Intensity

Light-O-Rama allows the possible intensity of most lighting effects ranges from 0 to 100, i.e. a
percentage of full intensity. DMX devices, however, are capable of taking 256 different intensities
(from O to 255), rather than 101. Light-O-Rama supports this possibility via the DMX Intensity tool.

However, this is only supported in the Advanced license lewvel. Other license levels will not have
access to the DMX Intensity tool.

Dasher Controllers Supported

The Advanced license level can send lighting commands to Dasher controllers, in addition to Light-
O-Rama controllers. Lower license levels can only send lighting commands to Light-O-Rama
controllers.

X10 Controllers Supported

The Advanced license lewvel can send lighting commands to X10 controllers, in addition to Light-O-
Rama controllers. Lower license levels can only send lighting commands to Light-O-Rama
controllers.

Digital 10 Cards Supported

The Advanced license lewvel can send lighting commands to digital 10 cards, in addition to Light-O-
Rama controllers. Lower license levels can only send lighting commands to Light-O-Rama
controllers.

BSOFT Digital 10 Cards Supported

The Advanced license level can send lighting commands to BSOFT digital 1O cards, in addition to
Light-O-Rama controllers. Lower license levels can only send lighting commands to Light-O-Rama
controllers.
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4 Light-O-Rama Concepts

Light-O-Rama allows your computer to control your lights and other equipment in synchronized displays.
Such a display is organized in a few levels:

At the lowest lewvel, a sequence contains commands to be sent to your Light-O-Rama hardware, which
will actually control your lights. For example, a sequence might contain a command to turn on one
string of lights while making another string twinkle, and two seconds later, fading the first string down
while fading the second string up. A sequence can contain commands for many circuits.

Sequence

A sequence contains commands for individual strings of lights

Typically, people build a sequence per song that they want in their display (known as musical
sequences), each one containing all of the lighting commands for its particular song. People also build
animation sequences, not associated with any particular song, and often build one for each independent
part of their display - for example, one animation sequence to control a group of snowmen having a
snowball fight, and another to control a tin soldier firing a cannon.

Sequences can be grouped together into shows. A show allows several sequences to be played at the
same time, or sequentially, or in random order. A show can contain different sections - for example,
some sequences might be played only at the beginning of a show, others only at the end, others in
between, and still others for the entire duration of the show.
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4.1

Sequence Sequence Sequence

A show contains sequences to be played together, or in order, or randomly

Finally, shows can be scheduled to be played at certain times. Only one show (at most) can be playing
at any given time, but any number of shows can be scheduled for different times, and the same show
can be scheduled to play at many different times.

A schedule is used to play shows at specific times

Sequences

A sequence is a set of commands to be sent to lights - for example, a sequence may command the
lights to turn on when the sequence starts, turn off a second later, stay off for a tenth of a second, start
twinkling for the next two seconds, and then fade up, from completely off to completely on, during the
next three seconds.

A sequence can control multiple sets of lights independently of each other. Each set of lights should be
hooked up to a particular circuit on a particular controller; each such circuit is referred to as a "channel”.

There are two types of sequences: animation sequences and musical sequences. Musical sequences
are associated with songs (or sound effects, videos, et cetera); the lights can be made to turn off and on
(and do other effects) in sync with the music. Animation sequences are not associated with songs.
Many sequences can be played simultaneously, but at most one musical sequence can be playing at a
time - all others must be animation sequences. This means that you can control some of your lights in
sync to a song via a musical sequence, while simultaneously controlling other lights independently, via
animation sequences.
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The Light-O-Rama Sequence Editor is used to create and modify sequences. After creating sequences
with the Sequence Editor, you can package sequences together into a show, using the Show Editor,
and then schedule shows to be played at certain times using the Schedule Editor. The Show Player (if
enabled, via the 